Introduction
This document outlines the device support, new features added in 2021-07, fixed issues and open issues in e² studio 2021-07.

Contents

1. Product Information ......................................................................................................... 3
   1.1 Supported Operating Systems ..................................................................................... 3
       1.1.1 Windows 64-bit product version ........................................................................... 3
       1.1.2 System requirements ........................................................................................... 3
       1.1.3 Linux version ........................................................................................................ 5
   1.2 Supported Toolchains – Windows Hosted .................................................................. 6
   1.3 Supported Toolchains – Linux Hosted ..................................................................... 7

2. Device Support ................................................................................................................. 8
   2.1 Project Generator Support – Windows Hosted .............................................................. 8
   2.2 Code Generator Support – Windows Host ................................................................. 16
   2.3 Smart Configurator Support – Windows Host ............................................................... 20
   2.4 Project Generator Support – Linux Hosted ................................................................. 23
   2.5 Smart Configurator Support – Linux Host ................................................................. 26

3. Smart Manual Support ................................................................................................... 28

4. What is new in 2021-07? ................................................................................................ 29

5. Useful workarounds and information for 2021-07 ...................................................... 37

6. Linux version .................................................................................................................. 50
   6.1 How to install ................................................................................................................ 50
   6.2 How to run .................................................................................................................... 50
   6.3 Register toolchain to e² studio .................................................................................. 50
       6.3.1 GNU ARM Embedded ....................................................................................... 50
       6.3.2 Linaro .................................................................................................................. 51
   6.4 How to build and debug RA applications Overview ................................................. 52
       6.4.1 Build .................................................................................................................... 52
       6.4.2 Debug .................................................................................................................. 52
   6.5 How to build and debug RZ Linux application Overview ......................................... 53
       6.5.1 How to add gdb-server to RZ/A Linux root file system .................................... 53
       6.5.2 Linux C/C++ Project generation and build ....................................................... 54
       6.5.3 GDB debug by using serial port communication ............................................... 55
7. Open Issues in 2021-07 ................................................................................................. 57

8. Appendix......................................................................................................................... 58
8.1 Website and Support ........................................................................................................ 58
8.2 Web Access and Privacy Policy ....................................................................................... 58
1. **Product Information**

1.1 **Supported Operating Systems**

These operating systems are officially supported by e² studio:

- Windows 8.1 64-bit
- Windows 10 64-bit

In addition, another official product build is available for Linux. This version supports:

- Ubuntu 20.04 LTS

No other Linux distributions are officially supported by e² studio.

e² studio now runs on Java 11 & does not support older Java versions.

1.1.1 **Windows 64-bit product version**

Please note that 2020-04 and later versions are 64-bit product build versions of the tool.

We would like to state that the workspaces and projects from 7.x versions of e² studio are fully compatible with 2021-04.

When opening a workspace from 7.x you will be shown a warning, and this is standard Eclipse behavior. This is shown because some metadata in the workspace can change between versions so a workspace will not always work with older versions of the tool.

- Projects are forward & backward compatible,
- Workspaces work when upgrading but it is not guaranteed to 100% work if you return the workspace to 7.8.

The switch to 64-bit has unfortunately meant that some functions have now been deprecated from the tooling due to this move for the base platform. The removed functionality is listed below:

- HEW Project Convertor
- Renesas RTOS views
- Mylyn integration
- Subversion integration

If you need this functionality then please remain on e² studio 7.8.

Linux tools are now only available in the Linux host version of e² studio.

1.1.2 **System requirements**

For Windows 64-bit version

- IBM PC/AT compatible
  - Windows® 10 (64-bit version)
  - Windows® 8.1 (64-bit version)
- Memory capacity: We recommend 8 GB or more. At least 4 GB.
- Capacity of hard disk: At least 2 GB of free space.
- Display: Graphics resolution should be at least 1024 x 768, and the mode should display at least 65,536 colors.
- Interface: USB 2.0
- Microsoft Visual C++ 2010 SP1 runtime library *
- Microsoft Visual C++ 2015-2019 runtime library *

*1. This software will be installed at the same time as the e² studio.
For Linux

- IBM PC/AT compatible
  - Ubuntu 20.04 LTS Desktop (64-bit version)
- Processor: 64-bit architecture (CPUs that have 32-bit architecture, are not supported.), 2 GHz or faster, CPU has dual cores or more
- Memory capacity: We recommend 2 GB or more.
- Capacity of hard disk: At least 2 GB of free space.
1.1.3 Linux version

The Linux product version of e² studio 2021-07 for Linux is based on the same content as the Windows release.

Therefore, documents of e² studio will be helpful for common usages. There are some differences, the Linux version only supports the RA and RZ device families in 2021-07.

For information on how to install the Linux product please refer to FAQ in below URL.

English: https://en-support.renesas.com/knowledgeBase/19934358
Japanese: https://ja-support.renesas.com/knowledgeBase/19934356

<table>
<thead>
<tr>
<th>Device Family</th>
<th>Windows Product Support</th>
<th>Linux Product Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>EC-1</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RA</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>RE</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RH850</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RL78</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RX</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RZ</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Synergy</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>(No RZ/G Linux Platform Tools)</td>
<td></td>
</tr>
</tbody>
</table>
1.2 Supported Toolchains – Windows Hosted

The following toolchains are supported in e² studio 2021-07.

<table>
<thead>
<tr>
<th>Device Family</th>
<th>Renesas</th>
<th>GNU Arm Embedded (*2)</th>
<th>Renesas GCC/ GNURZ/ARM (*3)</th>
<th>IAR (*4)</th>
<th>Green Hills (*5)</th>
</tr>
</thead>
<tbody>
<tr>
<td>RL78</td>
<td>Yes (CC-RL)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RX</td>
<td>Yes (CC-RX)</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RH850</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>RZ/ARM</td>
<td>No</td>
<td>No (*1)</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Synergy/ARM</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RA/ARM</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>RE/ARM</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:**

*1: Project converter is available to convert from GNUARM RZ.none to GNU ARM Embedded toolchain.

*2: The GCC toolchains for RZ Family and Renesas Synergy™ are distributed via Arm Developer at [https://developer.arm.com/open-source/gnu-toolchain/gnu-rm](https://developer.arm.com/open-source/gnu-toolchain/gnu-rm) or Launchpad.net at: [https://launchpad.net/gcc-arm-embedded](https://launchpad.net/gcc-arm-embedded). They are also available using the “Additional components” page in the e² studio installer. Supported ARM GCC versions vary from device family to device family. Please see the following table for more information:

<table>
<thead>
<tr>
<th>Device Family</th>
<th>GCC distribution and version</th>
</tr>
</thead>
<tbody>
<tr>
<td>RZ/A1, A2</td>
<td>6.3.1 (2017 q2)</td>
</tr>
<tr>
<td>RZ/G1, G2 (Cortex-A)</td>
<td>Linaro 7.3.1</td>
</tr>
<tr>
<td>RZ/G2 (Cortex-M33)</td>
<td>FSP 1.0.0: 9.2.1 (2019 q4)</td>
</tr>
<tr>
<td>Synergy</td>
<td>SSP 1.6.x: 7.2.1</td>
</tr>
<tr>
<td></td>
<td>SSP 1.7.x: 7.2.1</td>
</tr>
<tr>
<td></td>
<td>SSP 2.0.x: 9.3.1</td>
</tr>
<tr>
<td>RA</td>
<td>FSP 3.0.0: 9.3.1</td>
</tr>
<tr>
<td>RE</td>
<td>RE SDK 1.10: 6.3.1(2017 q2)</td>
</tr>
</tbody>
</table>

*3: Legacy GNUARM toolchains are available from [https://llvm-gcc-renesas.com](https://llvm-gcc-renesas.com). In addition, the latest RX and RL78 Renesas GCC toolchains are available from this website. Also LLVM for RL78 is available from [https://llvm-gcc-renesas.com](https://llvm-gcc-renesas.com).

*4: The IAR toolchain plugins are available via the “Help”->” IAR Embedded Workbench plugin manager” menu in e² studio. These Eclipse plugins are provided by IAR and are not supported by Renesas.

*5: The Green Hills toolchain plugins are available within the e² studio product. These plugins are provided by Green Hills and are not supported by Renesas.
1.3 Supported Toolchains – Linux Hosted

The following toolchains are supported in e² studio 2021-04:

- Linaro GCC – tested version 7.3.1-201805
- GNU Arm Embedded – tested version 7.3.1.2018.06022
## 2. Device Support

### 2.1 Project Generator Support – Windows Hosted

Note: The Renesas SH device family is no longer supported in e² studio.

<table>
<thead>
<tr>
<th>Family</th>
<th>Group</th>
<th>Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>EC</td>
<td>EC-1</td>
<td>R9A06G043</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R7FA2L1AB3CFP, R7FA2L1AB3CFN, R7FA2L1AB3CFM, R7FA2L1AB3CFL, R7FA2L1AB3CNE, R7FA2L1AB2DFP, R7FA2L1AB2DFN, R7FA2L1AB2DFM, R7FA2L1AB2DFL, R7FA2L1AB2DNE</td>
</tr>
<tr>
<td>RA2A1</td>
<td></td>
<td>R7FA2E1A93CFM, R7FA2E1A93CFK, R7FA2E1A93CFJ, R7FA2E1A93CFL, R7FA2E1A93CNH, R7FA2E1A93CBU, R7FA2E1A93CLM, R7FA2E1A93CBV, R7FA2E1A93CNH, R7FA2E1A93CBU, R7FA2E1A93CBV,</td>
</tr>
<tr>
<td>RA2E1</td>
<td></td>
<td>R7FA2E1A83CFM, R7FA2E1A83CFK, R7FA2E1A83CFJ, R7FA2E1A83CFL, R7FA2E1A83CNH, R7FA2E1A83CBU, R7FA2E1A83CLM, R7FA2E1A83CBV, R7FA2E1A83CNH, R7FA2E1A83CBU, R7FA2E1A83CBV,</td>
</tr>
<tr>
<td>RA</td>
<td></td>
<td>R7FA2E1A73CFM, R7FA2E1A73CFK, R7FA2E1A73CFJ, R7FA2E1A73CFL, R7FA2E1A73CNH, R7FA2E1A73CBU, R7FA2E1A73CLM, R7FA2E1A73CBV, R7FA2E1A73CNH, R7FA2E1A73CBU, R7FA2E1A73CBV,</td>
</tr>
<tr>
<td>RA4M1</td>
<td></td>
<td>R7FA4M1AB2CLJ, R7FA4M1AB3CFL, R7FA4M1AB3CFP, R7FA4M1AB3CNB, R7FA4M1AB3CNF, R7FA4M1AB3CFL,</td>
</tr>
<tr>
<td>RA4M2</td>
<td></td>
<td>R7FA4M2AF3CFP, R7FA4M2AF3CFM, R7FA4M2AF3CFL, R7FA4M2AF3CNE, R7FA4M2AD3CFP, R7FA4M2AD3CFM, R7FA4M2AD3CFL, R7FA4M2AD3CNE,</td>
</tr>
<tr>
<td>RA4M3</td>
<td></td>
<td>R7FA4M3AF3CFB, R7FA4M3AF3CFP, R7FA4M3AF3CFM, R7FA4M3AE3CFB, R7FA4M3AE3CFP, R7FA4M3AE3CFM, R7FA4M3AD3CFL,</td>
</tr>
<tr>
<td>RA6M1</td>
<td></td>
<td>R7FA6M1AD2CLJ, R7FA6M1AD3CFM, R7FA6M1AD3CFP, R7FA6M1AD3CNB, R7FA6M1AD3CFL,</td>
</tr>
<tr>
<td>RA6M2</td>
<td></td>
<td>R7FA6M2AD2CLK, R7FA6M2AD3CFL, R7FA6M2AD3CFP, R7FA6M2AF2CLK, R7FA6M2AF3CFB, R7FA6M2AF3CFP,</td>
</tr>
<tr>
<td>RE</td>
<td></td>
<td>R7F0E01BD2DNB</td>
</tr>
<tr>
<td>RE01B</td>
<td></td>
<td>R7F0E014D2CFB, R7F0E014D2CFP, R7F0E015D2CFB, R7F0E015D2CFP, R7F0E016D2DBN, R7F0E017D2DBN</td>
</tr>
<tr>
<td>RE01_1500KB</td>
<td></td>
<td>R7F0E01082CFM, R7F0E01082CFB, R7F0E01082DFC, R7F0E01082DFB, R7F0E01082DNG, R7F0E01182CFM, R7F0E01182CFB, R7F0E01182DFB, R7F0E01182DBH,</td>
</tr>
<tr>
<td>RE01_256KB</td>
<td></td>
<td>R7F0E01082CFM, R7F0E01082CFB, R7F0E01082DFC, R7F0E01082DFB, R7F0E01082DNG, R7F0E01182CFM, R7F0E01182CFB, R7F0E01182DFB, R7F0E01182DBH,</td>
</tr>
<tr>
<td>RH850</td>
<td>C1H</td>
<td>R7F701260, R7F701270,(Debug Support Only)</td>
</tr>
<tr>
<td>Model</td>
<td>Reference 1</td>
<td>Reference 2</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td>C1M</td>
<td>R7F701263, R7F701271,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>D1L1</td>
<td>R7F701401, R7F701421,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>D1L2</td>
<td>R7F701402, R7F701422,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>D1M</td>
<td>R7F701404, R7F701405,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>D1M1-V2</td>
<td>R7F701442, R7F701462,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>D1M2</td>
<td>R7F701408, R7F701410, R7F701428, R7F701430,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>E1L</td>
<td>R7F701201, R7F701205,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>E1M-S</td>
<td>R7F701202, R7F701204,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>E1M-S2</td>
<td>R7F701215, R7F701216,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>R7F701Z05, R7F701Z06, R7F701Z07,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>F1H</td>
<td>R7F701501, R7F701502, R7F701503, R7F701506, R7F701507, R7F701508, R7F701511, R7F701512, R7F701513,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>R7F701521, R7F701522, R7F701524, R7F701525,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>F1K</td>
<td>R7F701542, R7F701543, R7F701546, R7F701547, R7F701557, R7F701560, R7F701561, R7F701562, R7F701563, R7F701566, R7F701567, R7F701577, R7F701580, R7F701581, R7F701582, R7F701583, R7F701586, R7F701587, R7F701597, R7F701602, R7F701603, R7F701610, R7F701611, R7F701612, R7F701613, R7F701620, R7F701621, R7F701622, R7F701623,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>F1KH-D8</td>
<td>R7F701708, R7F701709, R7F701710, R7F701711, R7F701714, R7F701715,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>F1KM-S4</td>
<td>R7F701644, R7F701645, R7F701646, R7F701647, R7F701648, R7F701649, R7F701650, R7F701651, R7F701652, R7F701653, R7F701684, R7F701685, R7F701686, R7F701687, R7F701688, R7F701689, R7F701690, R7F701691, R7F701692, R7F701693, R7F701694, R7F701695, R7F701760, R7F701762, R7F701764,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>F1L</td>
<td>R7F701002xAFP, R7F701003xAFP, R7F701006xAFP, R7F701007xAFP, R7F701008xAFP, R7F701009xAFP, R7F701010xAFP, R7F701011xAFP, R7F701012xAFP, R7F701013xAFP, R7F701014xAFP, R7F701015xAFP, R7F701016xAFP, R7F701017xAFP, R7F701018xAFP, R7F701019xAFP, R7F701020xAFP, R7F701021xAFP, R7F701022xAFP, R7F701023xAFP, R7F701024xAFP, R7F701025xAFP, R7F701026xAFP, R7F701027xAFP, R7F701028xAFP, R7F701029xAFP, R7F701030xAFP, R7F701032xAFP, R7F701033xAFP, R7F701034xAFP, R7F701040, R7F701041, R7F701042, R7F701043, R7F701044, R7F701045, R7F701046, R7F701047, R7F701048, R7F701049, R7F701050, R7F701051, R7F701052, R7F701053, R7F701054, R7F701055, R7F701056, R7F701057,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>F1M</td>
<td>R7F701544, R7F701545, R7F701548, R7F701549, R7F701552, R7F701553, R7F701564, R7F701565, R7F701568, R7F701569, R7F701572, R7F701573,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>P1H-C</td>
<td>R7F701370AEABG, R7F701371EABG, R7F701372EABG, R7F701396EABG,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>P1L-C</td>
<td>R7F701388, R7F701389, R7F701390, R7F701391,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>P1M</td>
<td>R7F701304, R7F701305, R7F701310, R7F701311, R7F701312, R7F701313, R7F701314, R7F701315, R7F701318, R7F701319, R7F701320, R7F701321, R7F701322, R7F701323,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>P1M-C</td>
<td>R7F701373xxABG, R7F701374xAFP, R7F701397xxABG,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>P1M-E</td>
<td>R7F701375, R7F701376, R7F701377, R7F701378, R7F701379, R7F701380, R7F701381, R7F701382, R7F701383, R7F701384, R7F701385, R7F701386,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>R7F701060xAFP, R7F701062xAFP, R7F701064xAFP, R7F701065xAFP, R7F701067xAFP, R7F701069xAFP, R7F701071xAFP,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>R7F702Z19A,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>U2A16</td>
<td>R7F702300,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>U2A8</td>
<td>R7F702301,(Debug Support Only)</td>
<td></td>
</tr>
<tr>
<td>D1A</td>
<td>R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, R5F10CME, R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, R5F10DLE, R5F10DMD, R5F10DME, R5F10DFM, R5F10DMG, R5F10DMJ, R5F10DPE, R5F10DPF, R5F10DPG, R5F10DPJ, R5F10DPK, R5F10DPL, R5F10DSJ, R5F10DSK, R5F10DSL, R5F10TPJ</td>
<td></td>
</tr>
<tr>
<td>F13</td>
<td>R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC, R5F10AAD, R5F10AEE, R5F10ABC, R5F10ABD, R5F10ABE, R5F10AGA, R5F10AGC, R5F10AGD, R5F10AGE, R5F10AGF, R5F10AGG, R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, R5F10AMF, R5F10AMG, R5F10AMH, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBG, R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC, R5F10BLD, R5F10BLE, R5F10BLF, R5F10BLG, R5F10BME, R5F10BMF, R5F10BMG</td>
<td></td>
</tr>
<tr>
<td>RL78</td>
<td></td>
<td></td>
</tr>
<tr>
<td>F14</td>
<td>R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGG, R5F10PGE, R5F10PGF, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF, R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, R5F10PMF, R5F10PMG, R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPJ</td>
<td></td>
</tr>
<tr>
<td>F15</td>
<td>R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, R5F113ML, R5F113PG, R5F113PH, R5F113PJ, R5F113PL, R5F113PL, R5F113T, R5F113TH, R5F113TJ, R5F113TK, R5F113TL</td>
<td></td>
</tr>
<tr>
<td>F1A</td>
<td>R5F114GC, R5F114GD, R5F114GE, R5F114GF, R5F114GG</td>
<td></td>
</tr>
<tr>
<td>F1E</td>
<td>R5F11KLE, R5F11KLF, R5F11KLG, R5F11LLE, R5F11LLF, R5F11LLG</td>
<td></td>
</tr>
<tr>
<td>G10</td>
<td>R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47</td>
<td></td>
</tr>
<tr>
<td>G11</td>
<td>R5F1051A, R5F1054A, R5F1056A, R5F1057A, R5F1058A</td>
<td></td>
</tr>
</tbody>
</table>
G12

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C, R5F1007D, R5F1007E, R5F1008A, R5F1008C, R5F1008D, R5F1008E, R5F100AA, R5F100AC, R5F100AD, R5F100AE, R5F100AF, R5F100AG, R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG, R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, R5F100EG, R5F100EH, R5F100FA, R5F100FC, R5F100FD, R5F100FE, R5F100FF, R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA, R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH, R5F100GJ, R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE, R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK, R5F100JL, R5F100LC, R5F100LD, R5F100LE, R5F100LF, R5F100LG, R5F100LH, R5F100JJ, R5F100KL, R5F100LL, R5F100MF, R5F100MG, R5F100MH, R5F100MJ, R5F100MK, R5F100ML, R5F100PF, R5F100PG, R5F100PH, R5F100PJ, R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK, R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A, R5F1017C, R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D, R5F1018E, R5F1019A, R5F1019C, R5F1019D, R5F1019E, R5F1019F, R5F1019G, R5F1019H, R5F1019J, R5F1019K, R5F1019L, R5F1019M, R5F1019N, R5F1019O, R5F1019P, R5F1019Q, R5F1019R, R5F1019S, R5F1019T, R5F1019U, R5F1019V, R5F1019W, R5F1019X, R5F1019Y, R5F1019Z, R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, R5F101CG, R5F101CE, R5F101ED, R5F101EE, R5F101EF, R5F101EG, R5F101EH, R5F101FA, R5F101FC, R5F101FD, R5F101FE, R5F101FF, R5F101FG, R5F101FH, R5F101FJ, R5F101FK, R5F101FL, R5F101GA, R5F101GC, R5F101GD, R5F101GE, R5F101GF, R5F101GG, R5F101GH, R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101JJ, R5F101JK, R5F101JL, R5F101LC, R5F101LD, R5F101LE, R5F101LF, R5F101LG, R5F101LH, R5F101LI, R5F101LK, R5F101LL, R5F101MF, R5F101MG, R5F101MH, R5F101MJ, R5F101MK, R5F101ML, R5F101PF, R5F101PG, R5F101PH, R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F101SJ, R5F101SK, R5F101SL

G13

R5F140FK, R5F140FL, R5F140FK, R5F140GL, R5F140LK, R5F140LL, R5F140PK, R5F140PL

G13A

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG, R5F104BA, R5F104BC, R5F104BD, R5F104BE, R5F104BF, R5F104BG, R5F104CA, R5F104CC, R5F104CD, R5F104CE, R5F104CF, R5F104CG, R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, R5F104EG, R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC, R5F104GD, R5F104GE, R5F104GF, R5F104GH, R5F104GJ, R5F104GK, R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG, R5F104JH, R5F104JJ, R5F104KJ, R5F104LC, R5F104LD, R5F104LD, R5F104LE, R5F104LF, R5F104LG, R5F104LH, R5F104JL, R5F104JJ, R5F104KL, R5F104LL, R5F104MF, R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML, R5F104PF, R5F104PG, R5F104PH, R5F104PJ, R5F104PK, R5F104PL
<table>
<thead>
<tr>
<th>Section</th>
<th>Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>G1A</td>
<td>R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC, R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE, R5F10ELC, R5F10ELD, R5F10ELE</td>
</tr>
<tr>
<td>G1C</td>
<td>R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC</td>
</tr>
<tr>
<td>G1D</td>
<td>R5F11AGG, R5F11AGH, R5F11AGJ</td>
</tr>
<tr>
<td>G1E</td>
<td>R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME</td>
</tr>
<tr>
<td>G1F</td>
<td>R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, R5F11BCE, R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE</td>
</tr>
<tr>
<td>G1G</td>
<td>R5F11E8A, R5F11E8B, R5F11EBA, R5F11EF8, R5F11EFA</td>
</tr>
<tr>
<td>G1H</td>
<td>R5F11FLJ, R5F11FLK, R5F11FLL</td>
</tr>
<tr>
<td>G1K</td>
<td>R5F11VBG, R5F11VLG</td>
</tr>
<tr>
<td>G1M</td>
<td>R5F11W67, R5F11W68</td>
</tr>
<tr>
<td>G1N</td>
<td>R5F11Y67, R5F11Y68</td>
</tr>
<tr>
<td>G1P</td>
<td>R5F11Z7A, R5F11ZBA</td>
</tr>
<tr>
<td>G23</td>
<td>R7F100GAF, R7F100GAG, R7F100GAH, R7F100GAJ, R7F100GBF, R7F100GBG, R7F100GBH, R7F100GBJ, R7F100GCF, R7F100GCG, R7F100GCH, R7F100GCJ, R7F100GEF, R7F100EGE, R7F100GHE, R7F100GEJ, R7F100GFF, R7F100GFG, R7F100GHF, R7F100GFJ, R7F100GFK, R7F100GL, R7F100GLL, R7F100GLN, R7F100GMG, R7F100GGM, R7F100GJM, R7F100GML, R7F100GMN, R7F100GPG, R7F100GPH, R7F100GPJ, R7F100GPK, R7F100GPL, R7F100GPN, R7F100GSJ, R7F100GSK, R7F100GSL, R7F100GSN</td>
</tr>
<tr>
<td>H1D</td>
<td>R5F11NGF, R5F11NGG, R5F11NLF, R5F11NLG, R5F11NME, R5F11NMF, R5F11NMG, R5F11PLF, R5F11PLG, R5F11RMG</td>
</tr>
<tr>
<td>I1A</td>
<td>R5F1076C, R5F107AC, R5F107AE, R5F107DE</td>
</tr>
<tr>
<td>I1B</td>
<td>R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG</td>
</tr>
<tr>
<td>I1C</td>
<td>R5F10NLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ, R5F10NML, R5F10NML_DUAL, R5F10NPJ, R5F10NPJ, R5F10NPL, R5F10NPL_DUAL</td>
</tr>
<tr>
<td>I1C-2</td>
<td>R5F11TLE, R5F11TLG</td>
</tr>
<tr>
<td>I1D</td>
<td>R5F1176B, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA, R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC</td>
</tr>
<tr>
<td>I1E</td>
<td>R5F11CBC, R5F11CCC</td>
</tr>
<tr>
<td>L12</td>
<td>R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, R5F10RGA, R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC, R5F10RLA, R5F10RLC</td>
</tr>
<tr>
<td>L13</td>
<td>R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, R5F10WLG, R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, R5F10WMF, R5F10WMG</td>
</tr>
<tr>
<td>L1A</td>
<td>R5F11MMD, R5F11MME, R5F11MPE, R5F11MPF, R5F11MPG</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>L1C</td>
<td>R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, R5F110NE, R5F110NF, R5F110NG, R5F110NH, R5F110NJ, R5F110PE, R5F110PF, R5F110PG, R5F110PH, R5F110PJ, R5F111ME, R5F111MF, R5F111MG, R5F111MH, R5F111NE, R5F111NF, R5F111NG, R5F111NH, R5F111NJ, R5F111PE, R5F111PF, R5F111PG, R5F111PH, R5F111PJ</td>
</tr>
<tr>
<td>110</td>
<td>R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J</td>
</tr>
<tr>
<td>111</td>
<td>R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, R5F51118, R5F5111J</td>
</tr>
<tr>
<td>113</td>
<td>R5F51135, R5F51136, R5F51137, R5F51138</td>
</tr>
<tr>
<td>130</td>
<td>R5F51303, R5F51305, R5F51306, R5F51306B, R5F51307, R5F51308</td>
</tr>
<tr>
<td>13T</td>
<td>R5F513T3, R5F513T5</td>
</tr>
<tr>
<td>140</td>
<td>R5F51403</td>
</tr>
<tr>
<td>210</td>
<td>R5F52103, R5F52104, R5F52105, R5F52106, R5F52107, R5F52108, R5F5210A, R5F5210B</td>
</tr>
<tr>
<td>21A</td>
<td>R5F521A6, R5F521A7, R5F521A8</td>
</tr>
<tr>
<td>220</td>
<td>R5F52201, R5F52203, R5F52205, R5F52206</td>
</tr>
<tr>
<td>230</td>
<td>R5F52305, R5F52306</td>
</tr>
<tr>
<td>231</td>
<td>R5F52315, R5F52316, R5F52317, R5F52318</td>
</tr>
<tr>
<td>23E-A</td>
<td>R5F523E5A, R5F523E5S, R5F523E6A, R5F523E6S</td>
</tr>
<tr>
<td>23T</td>
<td>R5F523T3, R5F523T5</td>
</tr>
<tr>
<td>23W</td>
<td>R5F523W7, R5F523W8</td>
</tr>
<tr>
<td>24T</td>
<td>R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE</td>
</tr>
<tr>
<td>24U</td>
<td>R5F524UB, R5F524UC, R5F524UE</td>
</tr>
<tr>
<td>610</td>
<td>R5F56104, R5F56106, R5F56107, R5F56108</td>
</tr>
<tr>
<td>621</td>
<td>R5F56216, R5F56217, R5F56218</td>
</tr>
<tr>
<td>62G</td>
<td>R5F562G7, R5F562GA</td>
</tr>
<tr>
<td>62N</td>
<td>R5F562N7, R5F562N8</td>
</tr>
<tr>
<td>62T</td>
<td>R5F562T6, R5F562T7, R5F562TA</td>
</tr>
<tr>
<td>630</td>
<td>R5F56307, R5F56308, R5F5630A, R5F5630B, R5F5630D, R5F5630E</td>
</tr>
<tr>
<td>634</td>
<td>R5F5634B, R5F5634B_5V, R5F5634D, R5F5634D_5V, R5F5634E, R5F5634E_5V</td>
</tr>
<tr>
<td>63N</td>
<td>R5F563NA, R5F563NB, R5F563ND, R5F563NE, R5F563NF, R5F563NK, R5F563NW, R5F563NY</td>
</tr>
<tr>
<td>63T</td>
<td>R5F563T4, R5F563T5, R5F563T6, R5F563TB, R5F563TB_5V, R5F563TC, R5F563TC_5V, R5F563TE, R5F563TE_5V</td>
</tr>
<tr>
<td>64M</td>
<td>R5F564MF, R5F564MG, R5F564MJ, R5F564ML</td>
</tr>
</tbody>
</table>
651  
R5F56514, R5F56517, R5F56519, R5F5651C, R5F5651C_DUAL,  
R5F5651E, R5F5651E_DUAL  
R5F56519DMB, R5F5651EDMB, R5F5651EDMB_DUAL,(Debug Support Only)  

65N  
R5F565N4, R5F565N7, R5F565N9, R5F565NC, R5F565NC_DUAL,  
R5F565NE, R5F565NE_DUAL  
R5F565N9DMB, R5F565NEDMB, R5F565NEDMB_DUAL,(Debug Support Only)  

66N  
R5F566ND, R5F566ND_DUAL, R5F566NN, R5F566NN_DUAL  

66T  
R5F566TA, R5F566TE, R5F566TF, R5F566TK  

671  
R5F56719, R5F56719_DUAL, R5F5671C, R5F5671C_DUAL, R5F5671E,  
R5F5671E_DUAL  

71M  
R5F571MF, R5F571MG, R5F571MJ, R5F571ML  

72M  
R5F572MD, R5F572MD_DUAL, R5F572MN, R5F572MN_DUAL  

72N  
R5F572ND, R5F572ND_DUAL, R5F572NN, R5F572NN_DUAL  

72T  
R5F572TF, R5F572TK  
-  
R0E5571MLDMBXX,(Debug Support Only)  

A1  
R7S721000, R7S721000_DualSPI, R7S721001, R7S721001_DualSPI,  
R7S721010, R7S721010_DualSPI, R7S721011, R7S721011_DualSPI,  
R7S721020, R7S721020_DualSPI, R7S721021, R7S721021_DualSPI,  
R7S721030, R7S721030_DualSPI, R7S721031, R7S721031_DualSPI,  
R7S721034, R7S721034_DualSPI  

A2  
R7S921040, R7S921041, R7S921042, R7S921043, R7S921045,  
R7S921046, R7S921047, R7S921048, R7S921051, R7S921052,  
R7S921053, R7S921056, R7S921057, R7S921058  

G1E  
R8A77450, R8A77450_Core1,(Debug Support Only)  

G1M  
R8A77430, R8A77430_Core1,(Debug Support Only)  

G2  
R9A07G044L24GBG, R9A07G044L14GBG, R9A07G044L23GBG,  
R9A07G044L13GBG, R9A07G044L12GBG  

G2  
R8A77450, R8A77450_Core1,(Debug Support Only)  

G2  
R8A77430, R8A77430_Core1,(Debug Support Only)  

G2  
R9A07G044L24GBG, R9A07G044L14GBG, R9A07G044L23GBG,  
R9A07G044L13GBG, R9A07G044L12GBG  

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011,  
R7S910013, R7S910015, R7S910015_M3, R7S910016, R7S910016_M3,  
R7S910017, R7S910017_M3, R7S910018, R7S910018_M3, R7S910025,  
R7S910026, R7S910027, R7S910028, R7S910035, R7S910036,  
R7S910101, R7S910102, R7S910106, R7S910107, R7S910111,  
R7S910113, R7S910115, R7S910115_M3, R7S910116, R7S910116_M3,  
R7S910117, R7S910117_M3, R7S910118, R7S910118_M3, R7S910125,  
R7S910126, R7S910127, R7S910128, R7S910135, R7S910136  

T1-M  
R7S910020, R7S910021, R7S910022, R7S910023, R7S910120,  
R7S910121, R7S910122, R7S910123  

S1JA  
R7FS1JA783A01CFM, R7FS1JA783A01CNE, R7FS1JA783A01CNF,  
R7FS1JA782A01CBT, R7FS1JA783A01CFJ  

Synergy  
S124  
R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM,  
R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM,  
R7FS124773A01CBN, R7FS124773A01CNE, R7FS124773A01CNF  
R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL,  
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNF
<table>
<thead>
<tr>
<th>S3A1</th>
<th>R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ, R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM, R7FS3A17C3A01CFP, R7FS3A17C3A01CNB,</th>
</tr>
</thead>
<tbody>
<tr>
<td>S3A3</td>
<td>R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ, R7FS3A37A2A01CLJ, R7FS3A37A3A01CFP, R7FS3A37A3A01CFM, R7FS3A37A3A01CNB,</td>
</tr>
<tr>
<td>S3A6</td>
<td>R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7FS3A6783A01CFM, R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNE, R7FS3A6783A01CNF,</td>
</tr>
<tr>
<td>S3A7</td>
<td>R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, R7FS3A77C2A01CNB, R7FS3A77C3A01CNB</td>
</tr>
<tr>
<td>S5D3</td>
<td>R7FS5D37A2A01CLJ, R7FS5D37A3A01CFP, R7FS5D37A3A01CFM, R7FS5D37A3A01CNB, R7FS5D37A3A01CNB</td>
</tr>
<tr>
<td>S5D5</td>
<td>R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP, R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP</td>
</tr>
<tr>
<td>S5D9</td>
<td>R7FS5D97C2A01CBG, R7FS5D97C3A01CFB, R7FS5D97C2A01CLK, R7FS5D97C3A01CFB, R7FS5D97C3A01CFP, R7FS5D97C2A01CBG, R7FS5D97C3A01CFP, R7FS5D97C2A01CBG, R7FS5D97C3A01CFP</td>
</tr>
<tr>
<td>S7G2</td>
<td>R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7FS7G27H2A01CBG, R7FS7G27G2A01CBG, R7FS7G27G2A01CFB, R7FS7G27G2A01CFB, R7FS7G27G3A01CFP, R7FS7G27G3A01CFP</td>
</tr>
</tbody>
</table>
2.2 Code Generator Support – Windows Host

<table>
<thead>
<tr>
<th>Family</th>
<th>Group</th>
<th>Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, R5F10CME, R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, R5F10DLE, R5F10DMD, R5F10DME, R5F10DMF, R5F10DMG, R5F10DMJ, R5F10DPE, R5F10DPF, R5F10DPG, R5F10DPJ, D1A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC, R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE, R5F10AGA, R5F10AGC, R5F10AGD, R5F10AGE, R5F10AGF, R5F10AGG, R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, R5F10BAO, R5F10BBO, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBC, R5F10BGC, R5F10BBD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC, R5F10BLD, R5F10BLE, R5F10BLF, F13</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F10BPG, R5F10BME, R5F10BMF, R5F10BMG F14</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE, R5F10PGF, R5F10PFG, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF, R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, R5F10PMF, R5F10PMG, R5F10PMH, R5F10PMJ, R5F10PPF, R5F10PPG, R5F10PPH, R5F10PPJ F15</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F113GK, R5F113GL, R5F113LJ, R5F113LL, R5F113MK, R5F113ML, R5F113PG, R5F113PH, R5F113PJ, R5F113PK, R5F113PL, R5F113TG, R5F113TH, R5F113TJ, R5F113TK, R5F113TL F1E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F11KLE, R5F11KLF, R5F11KLG, R5F11LLL, R5F11LLF, R5F11LLG G10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47 G11</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277, R5F10278, R5F10279, R5F1027A, R5F102A7, R5F102A8, R5F102A9, R5F102AA, R5F10366, R5F10367, R5F10368, R5F10369, R5F1036A, R5F10377, R5F10378, R5F10379, R5F1037A, R5F1037A7, R5F1038A, RL78</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F1039A, R5F103AA G12</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>G1C</td>
<td>R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC</td>
<td></td>
</tr>
<tr>
<td>G1D</td>
<td>R5F11AGG, R5F11AGH, R5F11AGJ</td>
<td></td>
</tr>
<tr>
<td>G1E</td>
<td>R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME</td>
<td></td>
</tr>
<tr>
<td>G1F</td>
<td>R5F11B7C, R5F11B7E, R5F11B8C, R5F11B8E, R5F11BCC, R5F11BCE, R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE</td>
<td></td>
</tr>
<tr>
<td>G1G</td>
<td>R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, R5F11EFA</td>
<td></td>
</tr>
<tr>
<td>G1H</td>
<td>R5F11FLJ, R5F11FLK, R5F11FLL</td>
<td></td>
</tr>
<tr>
<td>H1D</td>
<td>R5F11NGG, R5F11NLF, R5F11NLG, R5F11NME, R5F11NMF, R5F11NMG, R5F11PLF, R5F11PLG, R5F11RMD</td>
<td></td>
</tr>
<tr>
<td>I1A</td>
<td>R5F1076C, R5F107AC, R5F107AE, R5F107DE</td>
<td></td>
</tr>
<tr>
<td>I1B</td>
<td>R5F10MME, R5F10MGG, R5F10MPG</td>
<td></td>
</tr>
<tr>
<td>I1C</td>
<td>R5F110LE, R5F10NLE, R5F10NMG, R5F10NML, R5F10NML_DUAL, R5F10NPG, R5F10NPJ, R5F10NPL, R5F10NPL_DUAL</td>
<td></td>
</tr>
<tr>
<td>I1C-2</td>
<td>R5F11TLE, R5F111LG</td>
<td></td>
</tr>
<tr>
<td>I1D</td>
<td>R5F11768, R5F1176A, R5F11778, R5F1177A, R5F1178A, R5F117AA, R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC</td>
<td></td>
</tr>
<tr>
<td>I1E</td>
<td>R5F11CBB, R5F11CCC</td>
<td></td>
</tr>
<tr>
<td>L12</td>
<td>R5F10RRA, R5F10RBA, R5F10RBC, R5F10RFA, R5F10RRA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, R5F10RGA, R5F10RGC, R5F10RJA, R5F10RJA, R5F10RJC, R5F10RLA, R5F10RLC</td>
<td></td>
</tr>
<tr>
<td>L13</td>
<td>R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, R5F10WLG, R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, R5F10WMF, R5F10WMG</td>
<td></td>
</tr>
<tr>
<td>L1A</td>
<td>R5F111ME, R5F111MME, R5F111MF, R5F111MPF, R5F111MPG</td>
<td></td>
</tr>
<tr>
<td>L1C</td>
<td>R5F111ME, R5F111MME, R5F111MF, R5F111MPF, R5F111MPG</td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J</td>
<td></td>
</tr>
<tr>
<td>111</td>
<td>R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, R5F51118, R5F5111J</td>
<td></td>
</tr>
<tr>
<td>113</td>
<td>R5F51135, R5F51136, R5F51137, R5F51138</td>
<td></td>
</tr>
<tr>
<td>130</td>
<td>R5F51303, R5F51305</td>
<td></td>
</tr>
<tr>
<td>230</td>
<td>R5F52305, R5F52306</td>
<td></td>
</tr>
<tr>
<td>231</td>
<td>R5F52315, R5F52316, R5F52317, R5F52318</td>
<td></td>
</tr>
<tr>
<td>23T</td>
<td>R5F523T3, R5F523T5</td>
<td></td>
</tr>
<tr>
<td>24T</td>
<td>R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE</td>
<td></td>
</tr>
<tr>
<td>24U</td>
<td>R5F524U5, R5F524UC, R5F524UE</td>
<td></td>
</tr>
<tr>
<td>64M</td>
<td>R5F564MF, R5F564MG, R5F564MJ, R5F564ML</td>
<td></td>
</tr>
<tr>
<td>RX</td>
<td>651</td>
<td>R5F56514, R5F56517, R5F56519</td>
</tr>
<tr>
<td>Model</td>
<td>Series/Model Numbers</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>-----------------------------------------</td>
<td></td>
</tr>
<tr>
<td>65N</td>
<td>R5F565N4, R5F565N7, R5F565N9</td>
<td></td>
</tr>
<tr>
<td>71M</td>
<td>R5F571MF, R5F571MG, R5F571MJ, R5F571ML</td>
<td></td>
</tr>
<tr>
<td></td>
<td>R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, R7S910013, R7S910015, R7S910016, R7S910017, R7S910018, R7S910025, R7S910026, R7S910027, R7S910028, R7S910035, R7S910036, R7S910101, R7S910102, R7S910106, R7S910107, R7S910111, R7S910113, R7S910115, R7S910116, R7S910117, R7S910118, R7S910125, R7S910126, R7S910127, R7S910128,</td>
<td></td>
</tr>
<tr>
<td>T1</td>
<td>R7S910135, R7S910136</td>
<td></td>
</tr>
</tbody>
</table>
## 2.3 Smart Configurator Support – Windows Host

<table>
<thead>
<tr>
<th>Family</th>
<th>Group</th>
<th>Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>RL78</td>
<td>G23</td>
<td>R7F100GAF, R7F100GAG, R7F100GAH, R7F100GAJ, R7F100GBF, R7F100GBG, R7F100GBH, R7F100GBJ, R7F100GCF, R7F100GGC, R7F100GCH, R7F100GCI, R7F100GEF, R7F100GEH, R7F100GEJ, R7F100GFF, R7F100GFG, R7F100GFFH, R7F100GFK, R7F100GFL, R7F100GFL, R7F100GFN, R7F100GFF, R7F100GFG, R7F100GGG, R7F100GGH, R7F100GGJ, R7F100GGK, R7F100GGL, R7F100GGN, R7F100GJF, R7F100GJG, R7F100GJH, R7F100GJJ, R7F100GJK, R7F100GJL, R7F100GJN, R7F100GLF, R7F100GLG, R7F100GLH, R7F100GLJ, R7F100GLK, R7F100GLL, R7F100GLN, R7F100GMG, R7F100GMH, R7F100GMJ, R7F100GMK, R7F100GML, R7F100GMN, R7F100GPG, R7F100GPH, R7F100GPJ, R7F100GPK, R7F100GPL, R7F100GPN, R7F100GQJ, R7F100GSK, R7F100GSL, R7F100GSN</td>
</tr>
<tr>
<td></td>
<td></td>
<td>RZ A2 R7S921040, R7S921041, R7S921042, R7S921043, R7S921045, R7S921046, R7S921047, R7S921048, R7S921051, R7S921052, R7S921053, R7S921056, R7S921057, R7S921058</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Family</th>
<th>Group</th>
<th>Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>RX</td>
<td></td>
<td>R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, R5F51118, R5F5111J</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F51135, R5F51136, R5F51137, R5F51138</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F51303, R5F51305, R5F51305B, R5F51306, R5F51306B, R5F51307, R5F51308</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F513T3, R5F513T5</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F51403</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F52305, R5F52306</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R5F52315, R5F52316, R5F52317, R5F52318</td>
</tr>
<tr>
<td></td>
<td>23E-A</td>
<td>R5F523E5A, R5F523E5S, R5F523E5A, R5F523E5S</td>
</tr>
<tr>
<td></td>
<td>23T</td>
<td>R5F523T3, R5F523T5</td>
</tr>
<tr>
<td></td>
<td>23W</td>
<td>R5F523W7, R5F523W8</td>
</tr>
<tr>
<td></td>
<td>24T</td>
<td>R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE</td>
</tr>
<tr>
<td></td>
<td>24U</td>
<td>R5F524UB, R5F524UC, R5F524UE</td>
</tr>
<tr>
<td></td>
<td>64M</td>
<td>R5F564MF, R5F564MG, R5F564MJ, R5F564ML</td>
</tr>
<tr>
<td></td>
<td>651</td>
<td>R5F56514, R5F56519, R5F56519, R5F5651C, R5F5651C_DUAL, R5F5651E, R5F5651E_DUAL</td>
</tr>
<tr>
<td></td>
<td>65N</td>
<td>R5F565N4, R5F565N7, R5F565N9, R5F565NC, R5F565NC_DUAL, R5F565NE, R5F565NE_DUAL</td>
</tr>
<tr>
<td></td>
<td>66N</td>
<td>R5F566ND, R5F566ND_DUAL, R5F566NN, R5F566NN_DUAL</td>
</tr>
<tr>
<td></td>
<td>66T</td>
<td>R5F566TA, R5F566TE, R5F566TF, R5F566TK</td>
</tr>
<tr>
<td></td>
<td>671</td>
<td>R5F56719, R5F56719_DUAL, R5F5671C, R5F5671C_DUAL, R5F5671E, R5F5671E_DUAL</td>
</tr>
<tr>
<td></td>
<td>71M</td>
<td>R5F571MF, R5F571MG, R5F571MJ, R5F571ML</td>
</tr>
<tr>
<td></td>
<td>72M</td>
<td>R5F572MD, R5F572MD_DUAL, R5F572MN, R5F572MN_DUAL</td>
</tr>
<tr>
<td></td>
<td>72N</td>
<td>R5F572ND, R5F572ND_DUAL, R5F572NN, R5F572NN_DUAL</td>
</tr>
<tr>
<td></td>
<td>72T</td>
<td>R5F572TF, R5F572TK</td>
</tr>
</tbody>
</table>
G2
R9A07G044L24BG, R9A07G044L14BG, R9A07G044L23BG,
R9A07G044L13BG, R9A07G044C22BG, R9A07G044C12BG

S1JA
R7FS1J783A01CFM, R7FS1J783A01CNE, R7FS1J783A01CNF,
R7FS1J782A01CBT, R7FS1J783A01CFJ

S124
R7FS124762A01CLM, R7FS124763A01CFM, R7FS124772A01CLM,
R7FS124773A01CFM, R7FS124773A01CNB, R7FS124773A01CNE,
R7FS124773A01CNF

S128
R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL,
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNG

S3A1
R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ,
R7FS3A17C3A01CFM, R7FS3A17C3A01CFP, R7FS3A17C3A01CNB

S3A3
R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ,
R7FS3A37A3A01CFM, R7FS3A37A3A01CFP, R7FS3A37A3A01CNB

S3A6
R7FS3A6782A01CLJ, R7FS3A6783A01CFM, R7FS3A6783A01CNB,
R7FS3A6783A01CNE, R7FS3A6783A01CNF

Synergy
S3A7
R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ,
R7FS3A77C3A01CFM, R7FS3A77C2A01CNB, R7FS3A77C3A01CNB

SSD3
R7FS5D37A2A01CLJ, R7FS5D37A3A01CFP, R7FS5D37A3A01CFM,
R7FS5D37A3A01CNB

SSD5
R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP,
R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP

SSD9
R7FS5D97C2A01CBG, R7FS5D97C3A01CFB, R7FS5D97C2A01CLK,
R7FS5D97C3A01CFB, R7FS5D97E2A01CBG, R7FS5D97E3A01CFB,
R7FS5D97E3A01CFP

S7G2
R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7FS7G27H2A01CBG,
R7FS7G27G2A01CBG, R7FS7G27H3A01CFC, R7FS7G27H3A01CFB,
R7FS7G27G2A01CFB, R7FS7G27G3A01CFB, R7FS7G27H2A01CLK,
R7FS7G27G2A01CLK, R7FS7G27H3A01CFB, R7FS7G27G3A01CFP

RA2A1
R7FA2L1A3BCFP, R7FA2L1AB3CFN, R7FA2L1AB3CFM, R7FA2L1AB3CFL,
R7FA2L1AB3CNE, R7FA2L1AB2DFP, R7FA2L1AB2DFN, R7FA2L1AB2DFM,
R7FA2L1AB2DNL, R7FA2L1AB2DNE

RA
R7FA2E1A93CFM, R7FA2E1A93CFK, R7FA2E1A93CFL, R7FA2E1A93CFJ,
R7FA2E1A93CNH, R7FA2E1A93CBU, R7FA2E1A93CLM, R7FA2E1A93CBV,
R7FA2E1A93CNE, R7FA2E1A92DFM, R7FA2E1A92DFK, R7FA2E1A92DFL,
R7FA2E1A92DFJ, R7FA2E1A92DHN, R7FA2E1A92DBU, R7FA2E1A92DLM,
R7FA2E1A92DBV, R7FA2E1A92DNE, R7FA2E1A83CFM, R7FA2E1A83CFK,
R7FA2E1A83CFL, R7FA2E1A83CFJ, R7FA2E1A83CNH, R7FA2E1A83CBU,
R7FA2E1A83CNE, R7FA2E1A83CBV, R7FA2E1A83CLM, R7FA2E1A83CBV,
R7FA2E1A83CFM, R7FA2E1A83CFL, R7FA2E1A83CFJ, R7FA2E1A83CNH,
R7FA2E1A83CBU, R7FA2E1A83CNE, R7FA2E1A83CBV, R7FA2E1A83CLM,
R7FA2E1A82DFK, R7FA2E1A82DFL, R7FA2E1A82DFJ, R7FA2E1A82DNH, R7FA2E1A82DBU, R7FA2E1A82DLM, R7FA2E1A82DBV, R7FA2E1A82DNE, R7FA2E1A73CFM, R7FA2E1A73CFK, R7FA2E1A73CFL, R7FA2E1A73CFJ, R7FA2E1A73CNH, R7FA2E1A73CBU, R7FA2E1A73CLM, R7FA2E1A73CBV, R7FA2E1A73CNE, R7FA2E1A72DFM, R7FA2E1A72DFK, R7FA2E1A72DFL, R7FA2E1A72DFJ, R7FA2E1A72DNH, R7FA2E1A72DBU, R7FA2E1A72DLM, R7FA2E1A72DBV, R7FA2E1A72DNE, R7FA2E1A53CFL, R7FA2E1A53CFJ, R7FA2E1A53CNH, R7FA2E1A53CLM, R7FA2E1A53CBV, R7FA2E1A53CFJ, R7FA2E1A53CNE, R7FA2E1A52DFL, R7FA2E1A52DNH, R7FA2E1A52DLM, R7FA2E1A52DBV, R7FA2E1A52DNE

| RA4M1 | R7FA4M1AB2CLJ, R7FA4M1AB3CFL, R7FA4M1AB3CFM, R7FA4M1AB3CFP, R7FA4M1AB3CNB, R7FA4M1AB3CNE, R7FA4M1AB3CNF |
|-----------------------------|
| RA4M2 | R7FA4M2AF3CFP, R7FA4M2AF3CFM, R7FA4M2AF3CFL, R7FA4M2AF3CNE, R7FA4M2AD3CFP, R7FA4M2AD3CFM, R7FA4M2AD3CFL, R7FA4M2AD3CNE |
| RA4M3 | R7FA4M3AF3CFB, R7FA4M3AF3CFP, R7FA4M3AF3CFM, R7FA4M3AE3CFB, R7FA4M3AE3CFP, R7FA4M3AE3CFM, R7FA4M3AD3CFB |
| RA6M1 | R7FA6M1AD2CLJ, R7FA6M1AD3CFM, R7FA6M1AD3CFP, R7FA6M1AD3CNB |
| RA6M2 | R7FA6M2AD2CLK, R7FA6M2AD3CFB, R7FA6M2AD3CFP, R7FA6M2AF2CLK, R7FA6M2AF3CFB, R7FA6M2AF3CFP |
| RA6M3 | R7FA6M3AF2CBG, R7FA6M3AF2CLK, R7FA6M3AF3CFB, R7FA6M3AF3CFM, R7FA6M3AH2CBG, R7FA6M3AH2CLK, R7FA6M3AH3CFB, R7FA6M3AH3CFC, R7FA6M3AH3CFP |
| RA6M4 | R7FA6M4AF3CFB, R7FA6M4AF3CFP, R7FA6M4AF3CFM, R7FA6M4AE3CFB, R7FA6M4AE3CFM, R7FA6M4AD3CFB, R7FA6M4AD3CFP, R7FA6M4AD3CFM |
| RA6T1 | R7FA6T1AD3CFP, R7FA6T1AB3CFP, R7FA6T1AD3CFM, R7FA6T1AB3CFM |
| RA4W1 | R7FA4W1AD2CNG |
### 2.4 Project Generator Support – Linux Hosted

<table>
<thead>
<tr>
<th>Family</th>
<th>Group</th>
<th>Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td>RA2A1</td>
<td></td>
<td>R7FA2L1AB3CFP, R7FA2L1AB3CFN, R7FA2L1AB3CFM, R7FA2L1AB3CFL, R7FA2L1AB3CNE, R7FA2L1AB2DFP, R7FA2L1AB2DFN, R7FA2L1AB2DFM, R7FA2L1AB2DNE</td>
</tr>
<tr>
<td>RA2E1</td>
<td></td>
<td>R7FA2E1A93CFM, R7FA2E1A93CFK, R7FA2E2A93CNH, R7FA2E2A93CBU, R7FA2E1A93CLM, R7FA2E1A93CBV, R7FA2E1A93CNE, R7FA2E1A92DFM, R7FA2E1A92DFK, R7FA2E1A92DFL, R7FA2E1A92DFJ, R7FA2E1A92DNH, R7FA2E1A92DBU, R7FA2E1A92DLM, R7FA2E1A92DBV, R7FA2E1A92DNE, R7FA2E1A83CFM, R7FA2E1A83CFK, R7FA2E1A83CFL, R7FA2E1A83CFJ, R7FA2E1A83CNH, R7FA2E1A83CBU, R7FA2E1A83CLM, R7FA2E1A83CBV, R7FA2E1A83CNE, R7FA2E1A82DFM, R7FA2E1A82DFK, R7FA2E1A82DFL, R7FA2E1A82DFJ, R7FA2E1A82DNH, R7FA2E1A82DBU, R7FA2E1A82DLM, R7FA2E1A82DBV, R7FA2E1A82DNE, R7FA2E1A73CFM, R7FA2E1A73CFK, R7FA2E1A73CFL, R7FA2E1A73CFJ, R7FA2E1A73CNH, R7FA2E1A73CBU, R7FA2E1A73CLM, R7FA2E1A73CBV, R7FA2E1A73CNE, R7FA2E1A72DFM, R7FA2E1A72DFK, R7FA2E1A72DFL, R7FA2E1A72DFJ, R7FA2E1A72DNH, R7FA2E1A72DBU, R7FA2E1A72DLM, R7FA2E1A72DBV, R7FA2E1A72DNE, R7FA2E1A53CFM, R7FA2E1A53CFK, R7FA2E1A53CFL, R7FA2E1A53CFJ, R7FA2E1A53CNH, R7FA2E1A53CBU, R7FA2E1A53CLM, R7FA2E1A53CBV, R7FA2E1A53CNE, R7FA2E1A52DFL, R7FA2E1A52DFJ, R7FA2E1A52DNH, R7FA2E1A52DBV, R7FA2E1A52DLM, R7FA2E1A52DBV, R7FA2E1A52DNE</td>
</tr>
<tr>
<td>RA4M1</td>
<td></td>
<td>R7FA4M1AB2CLJ, R7FA4M1AB3CFL, R7FA4M1AB3CFM, R7FA4M1AB3CFP, R7FA4M1AB3CNB, R7FA4M1AB3CNE, R7FA4M1AB3CNF</td>
</tr>
<tr>
<td>RA4M2</td>
<td></td>
<td>R7FA4M2AF3CFM, R7FA4M2AF3CFL, R7FA4M2AF3CNE, R7FA4M2AD3CFP, R7FA4M2AD3CFL, R7FA4M2AD3CNE</td>
</tr>
<tr>
<td>RA4M3</td>
<td></td>
<td>R7FA4M3AF3CFB, R7FA4M3AF3CFP, R7FA4M3AF3CFL, R7FA4M3AF3CNE, R7FA4M3AE3CFB, R7FA4M3AE3CFP, R7FA4M3AE3CFL, R7FA4M3AD3CFB</td>
</tr>
<tr>
<td>RA6M1</td>
<td></td>
<td>R7FA6M1AD2CLJ, R7FA6M1AD3CFM, R7FA6M1AD3CFP, R7FA6M1AD3CNB</td>
</tr>
<tr>
<td>RA6M2</td>
<td></td>
<td>R7FA6M2AD2CLK, R7FA6M2AD3CFB, R7FA6M2AD3CNE, R7FA6M2AF2CLK, R7FA6M2AF3CFB, R7FA6M2AF3CNE</td>
</tr>
<tr>
<td>RZ</td>
<td>A1</td>
<td>R7ST721000, R7ST721000_DualSPI, R7ST721001, R7ST721001_DualSPI, R7ST721010, R7ST721010_DualSPI, R7ST721011, R7ST721011_DualSPI, R7ST721020, R7ST721020_DualSPI, R7ST721021, R7ST721021_DualSPI, R7ST721030, R7ST721030_DualSPI, R7ST721031, R7ST721031_DualSPI, R7ST721034, R7ST721034_DualSPI</td>
</tr>
<tr>
<td>Synergy</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>S3A1</td>
<td>R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CJB, R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM, R7FS3A17C3A01CFP, R7FS3A17C3A01CNB</td>
<td></td>
</tr>
<tr>
<td>S3A3</td>
<td>R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CJB, R7FS3A37A2A01CLJ, R7FS3A37A3A01CFP, R7FS3A37A3A01CFM, R7FS3A37A3A01CNB</td>
<td></td>
</tr>
<tr>
<td>S3A6</td>
<td>R7FS3A6782A01CLK, R7FS3A6782A01CFB, R7FS3A6782A01CJB, R7FS3A6782A01CLJ, R7FS3A6782A01CFP, R7FS3A6782A01CFM, R7FS3A6782A01CNB, R7FS3A6782A01CNE, R7FS3A6782A01CNF</td>
<td></td>
</tr>
<tr>
<td>S3A7</td>
<td>R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CJB, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFP, R7FS3A77C2A01CNB, R7FS3A77C3A01CNB</td>
<td></td>
</tr>
<tr>
<td>S5D3</td>
<td>R7FS5D37A2A01CLK, R7FS5D37A3A01CFP, R7FS5D37A3A01CFM, R7FS5D37A3A01CNB</td>
<td></td>
</tr>
<tr>
<td>S5D5</td>
<td>R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A2A01CJB, R7FS5D57A2A01CLJ, R7FS5D57A3A01CFP, R7FS5D57A3A01CNB, R7FS5D57A3A01CNF</td>
<td></td>
</tr>
<tr>
<td>S5D9</td>
<td>R7FS5D97C2A01CBG, R7FS5D97C3A01CFB, R7FS5D97C2A01CLJ, R7FS5D97C3A01CFM, R7FS5D97C3A01CNE, R7FS5D97C3A01CNF</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T1-M</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>S1JA</td>
<td>R7FS1JA783A01CFM, R7FS1JA783A01CNE, R7FS1JA783A01CNF, R7FS1JA782A01CBT, R7FS1JA783A01CFJ</td>
<td></td>
</tr>
<tr>
<td>S124</td>
<td>R7FS124762A01CLM, R7FS124763A01CFM, R7FS124772A01CLM, R7FS124772A01CFM, R7FS124773A01CNE, R7FS124773A01CNF</td>
<td></td>
</tr>
<tr>
<td>S128</td>
<td>R7FS128782A01CLM, R7FS128783A01CFM, R7FS128783A01CFB, R7FS128783A01CNB, R7FS128783A01CNB</td>
<td></td>
</tr>
<tr>
<td>S3A1</td>
<td>R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CJB, R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM, R7FS3A17C3A01CFP, R7FS3A17C3A01CNB</td>
<td></td>
</tr>
<tr>
<td>S3A3</td>
<td>R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CJB, R7FS3A37A2A01CLJ, R7FS3A37A3A01CFP, R7FS3A37A3A01CFM, R7FS3A37A3A01CNB</td>
<td></td>
</tr>
<tr>
<td>S3A6</td>
<td>R7FS3A6782A01CLK, R7FS3A6782A01CFB, R7FS3A6782A01CJB, R7FS3A6782A01CLJ, R7FS3A6782A01CFP, R7FS3A6782A01CFM, R7FS3A6782A01CNB, R7FS3A6782A01CNE, R7FS3A6782A01CNF</td>
<td></td>
</tr>
<tr>
<td>S3A7</td>
<td>R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CJB, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFP, R7FS3A77C2A01CNB, R7FS3A77C3A01CNB</td>
<td></td>
</tr>
<tr>
<td>S5D3</td>
<td>R7FS5D37A2A01CLK, R7FS5D37A3A01CFP, R7FS5D37A3A01CFM, R7FS5D37A3A01CNB</td>
<td></td>
</tr>
<tr>
<td>S5D5</td>
<td>R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A2A01CJB, R7FS5D57A2A01CLJ, R7FS5D57A3A01CFP, R7FS5D57A3A01CNB, R7FS5D57A3A01CNF</td>
<td></td>
</tr>
<tr>
<td>S5D9</td>
<td>R7FS5D97C2A01CBG, R7FS5D97C3A01CFB, R7FS5D97C2A01CLJ, R7FS5D97C3A01CFM, R7FS5D97C3A01CNE, R7FS5D97C3A01CNF</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>T1</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>G2B</td>
<td>R7S91001001, R7S910002, R7S910006, R7S910007, R7S910011, R7S910013, R7S910015, R7S910015_M3, R7S910016, R7S910016_M3, R7S910017, R7S910017_M3, R7S910018, R7S910018_M3, R7S910025, R7S910026, R7S910027, R7S910028, R7S910035, R7S910036, R7S910101, R7S910102, R7S910106, R7S910107, R7S910111, R7S910113, R7S910115, R7S910115_M3, R7S910116, R7S910116_M3, R7S910117, R7S910117_M3, R7S910118, R7S910118_M3, R7S910125, R7S910126, R7S910127, R7S910128, R7S910135, R7S910136</td>
<td></td>
</tr>
<tr>
<td></td>
<td>R7FS5D97E2A01CBG, R7FS5D97E3A01CFC, R7FS5D97E2A01CLK, R7FS5D97E3A01CFB, R7FS5D97E3A01CFP</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>S7G2</td>
<td>R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7FS7G27H2A01CBG, R7FS7G27G2A01CBG, R7FS7G27H3A01CFC, R7FS7G27G3A01CFC, R7FS7G27G3A01CFB, R7FS7G27G3A01CFP</td>
<td></td>
</tr>
</tbody>
</table>
### 2.5 Smart Configurator Support – Linux Host

<table>
<thead>
<tr>
<th>Family</th>
<th>Group</th>
<th>Devices</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S1JA</td>
<td>R7FS1JA783A01CFM, R7FS1JA783A01CNF, R7FS1JA782A01CBT, R7FS1JA783A01CFJ</td>
</tr>
<tr>
<td></td>
<td>S124</td>
<td>R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM, R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM, R7FS124773A01CNB, R7FS124773A01CNF</td>
</tr>
<tr>
<td></td>
<td>S128</td>
<td>R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL, R7FS128783A01CNF, R7FS128783A01CNB</td>
</tr>
<tr>
<td></td>
<td>S3A1</td>
<td>R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ, R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM, R7FS3A17C3A01CFP, R7FS3A17C3A01CNB</td>
</tr>
<tr>
<td></td>
<td>S3A3</td>
<td>R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ, R7FS3A37A2A01CLJ, R7FS3A37A3A01CFM, R7FS3A37A3A01CFP, R7FS3A37A3A01CNB</td>
</tr>
<tr>
<td></td>
<td>S3A6</td>
<td>R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7FS3A6783A01CFM, R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNF</td>
</tr>
<tr>
<td></td>
<td>S3A7</td>
<td>R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, R7FS3A77C3A01CFP, R7FS3A77C3A01CNB</td>
</tr>
<tr>
<td></td>
<td>S5D3</td>
<td>R7FS5D37A2A01CLK, R7FS5D37A3A01CFM, R7FS5D37A3A01CNB</td>
</tr>
<tr>
<td></td>
<td>S5D5</td>
<td>R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP, R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP</td>
</tr>
<tr>
<td></td>
<td>S5D9</td>
<td>R7FS5D97C2A01CBG, R7FS5D97C3A01CFB, R7FS5D97C3A01CFP, R7FS5D97E2A01CBG, R7FS5D97E3A01CFB, R7FS5D97E3A01CFP</td>
</tr>
<tr>
<td></td>
<td>S7G2</td>
<td>R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7FS7G27H2A01CBG, R7FS7G27G2A01CBG, R7FS7G27H2A01CFC, R7FS7G27H2A01CFC, R7FS7G27H2A01CFP, R7FS7G27G2A01CFP, R7FS7G27H2A01CFM, R7FS7G27G2A01CFM</td>
</tr>
<tr>
<td></td>
<td>RA</td>
<td>R7FA2L1AB3CFP, R7FA2L1AB3CFN, R7FA2L1AB3CFM, R7FA2L1AB3CFL, R7FA2L1AB3CNE, R7FA2L1AB2DFP, R7FA2L1AB2DFN, R7FA2L1AB2DFM, R7FA2L1AB2DNL, R7FA2L1AB2DNE</td>
</tr>
</tbody>
</table>

**Synergy**

| S1JA  | R7FS1JA783A01CFM, R7FS1JA783A01CNF, R7FS1JA782A01CBT, R7FS1JA783A01CFJ |
| S124  | R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM, R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM, R7FS124773A01CNB, R7FS124773A01CNF |
| S128  | R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL, R7FS128783A01CNF, R7FS128783A01CNB |
| S3A1  | R7FS3A17C2A01CLK, R7FS3A17C3A01CFB, R7FS3A17C2A01CBJ, R7FS3A17C2A01CLJ, R7FS3A17C3A01CFM, R7FS3A17C3A01CFP, R7FS3A17C3A01CNB |
| S3A3  | R7FS3A37A2A01CLK, R7FS3A37A3A01CFB, R7FS3A37A2A01CBJ, R7FS3A37A2A01CLJ, R7FS3A37A3A01CFM, R7FS3A37A3A01CFP, R7FS3A37A3A01CNB |
| S3A6  | R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7FS3A6783A01CFM, R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNF |
| S3A7  | R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, R7FS3A77C3A01CFP, R7FS3A77C3A01CNB |
| S5D3  | R7FS5D37A2A01CLK, R7FS5D37A3A01CFM, R7FS5D37A3A01CNB |
| S5D5  | R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP, R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP |
| S5D9  | R7FS5D97C2A01CBG, R7FS5D97C3A01CFB, R7FS5D97C3A01CFP, R7FS5D97E2A01CBG, R7FS5D97E3A01CFB, R7FS5D97E3A01CFP |
| S7G2  | R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7FS7G27H2A01CBG, R7FS7G27G2A01CBG, R7FS7G27H2A01CFC, R7FS7G27H2A01CFC, R7FS7G27H2A01CFP, R7FS7G27G2A01CFP, R7FS7G27H2A01CFM, R7FS7G27G2A01CFM |

**RA**

| RA    | R7FA2L1AB3CFP, R7FA2L1AB3CFN, R7FA2L1AB3CFM, R7FA2L1AB3CFL, R7FA2L1AB3CNE, R7FA2L1AB2DFP, R7FA2L1AB2DFN, R7FA2L1AB2DFM, R7FA2L1AB2DNL, R7FA2L1AB2DNE |
| RA2E1 | R7FA2E1A93CFM, R7FA2E1A93CFK, R7FA2E1A93CFL, R7FA2E1A93CFJ, R7FA2E1A93CNH, R7FA2E1A93CBU, R7FA2E1A93CLM, R7FA2E1A93CBV, R7FA2E1A93CNE, R7FA2E1A92DFM, R7FA2E1A92DFK, R7FA2E1A92DFL, R7FA2E1A92DFJ, R7FA2E1A92DNH, R7FA2E1A92DBU, R7FA2E1A92DBV, R7FA2E1A92DNE, R7FA2E1A92DFK, R7FA2E1A83CFM, R7FA2E1A83CFK, R7FA2E1A83CFL, R7FA2E1A83CFJ, R7FA2E1A83CNH, R7FA2E1A83CBU, R7FA2E1A83CLM, R7FA2E1A83CBV, R7FA2E1A83CNE, R7FA2E1A82DFM, R7FA2E1A82DFK, R7FA2E1A82DFL, R7FA2E1A82DFJ, R7FA2E1A82DNH, R7FA2E1A82DBU, R7FA2E1A82DBV, R7FA2E1A82DNE, R7FA2E1A82DFK, R7FA2E1A73CFM, R7FA2E1A73CFK, R7FA2E1A73CFL, R7FA2E1A73CFJ, R7FA2E1A73CNH, R7FA2E1A73CBU, R7FA2E1A73CLM, R7FA2E1A73CBV, R7FA2E1A73CNE, R7FA2E1A72DFM, R7FA2E1A72DFK, R7FA2E1A72DFL, R7FA2E1A72DFJ, R7FA2E1A72DNH, R7FA2E1A72DBU, R7FA2E1A72DBV, R7FA2E1A72DNE, R7FA2E1A72DFK, R7FA2E1A53CFM, R7FA2E1A53CFK, R7FA2E1A53CFL, R7FA2E1A53CFJ, R7FA2E1A53CNH, R7FA2E1A53CBU, R7FA2E1A53CLM, R7FA2E1A53CBV, R7FA2E1A53CNE, R7FA2E1A52DFM, R7FA2E1A52DFK, R7FA2E1A52DFL, R7FA2E1A52DFJ, R7FA2E1A52DNH, R7FA2E1A52DBU, R7FA2E1A52DBV, R7FA2E1A52DNE |
| RA4M1 | R7FA4M1AB2CLJ, R7FA4M1AB3CFL, R7FA4M1AB3CFM, R7FA4M1AB3CFP, R7FA4M1AB3CNE, R7FA4M1AB3CNB, R7FA4M1AB3CNF |
| RA4M2 | R7FA4M2AF3CFP, R7FA4M2AF3CFM, R7FA4M2AF3CFL, R7FA4M2AF3CNE, R7FA4M2AD3CFP, R7FA4M2AD3CFM, R7FA4M2AD3CFL, R7FA4M2AD3CNE |
| RA4M3 | R7FA4M3AF3CFB, R7FA4M3AF3CFP, R7FA4M3AF3CFM, R7FA4M3AE3CFB, R7FA4M3AE3CFP, R7FA4M3AE3CFM, R7FA4M3AD3CFB |
| RA6M1 | R7FA6M1AD2CLJ, R7FA6M1AD3CFM, R7FA6M1AD3CFP, R7FA6M1AD3CNB |
| RA6M2 | R7FA6M2AD2CLK, R7FA6M2AD3CFB, R7FA6M2AD3CFP, R7FA6M2AF2CLK, R7FA6M2AF3CFB, R7FA6M2AF3CFP |
| RA6M3 | R7FA6M3AF2CBG, R7FA6M3AF2CLK, R7FA6M3AF3CFB, R7FA6M3AF3CFP, R7FA6M3AF2CG, R7FA6M3AH2CBG, R7FA6M3AH2CLK, R7FA6M3AH3CFB, R7FA6M3AH3CFP |
| RA6M4 | R7FA6M4AF3CFB, R7FA6M4AF3CFP, R7FA6M4AF3CFM, R7FA6M4AE3CFB, R7FA6M4AE3CFP, R7FA6M4AE3CFM, R7FA6M4AD3CFB, R7FA6M4AD3CFP |
| RA6T1 | R7FA6T1AD3CFP, R7FA6T1AB3CFP, R7FA6T1AD3CFM, R7FA6T1AB3CFM |
| RA4W1 | R7FA4W1AD2CNG |
3. **Smart Manual Support**

Smart manual support is delivered independently of e² studio releases when available. The following devices are available as of July 2021:

- RX110
- RX111
- RX113
- RX130
- RX210
- RX220
- RX230
- RX231
- RX23E-A
- RX24U
- RX24T
- RX62G
- RX62T
- RX631
- RX63N
- RX63T
- RX651
- RX64M
- RX65N
- RX66T
- RX71M
- RX72M
- RX72T
- RL78/G10
- RL78/G11
- RL78/G12
- RL78/G13
- RL78/G14
- RL78/G1F
- RL78/L12
- RL78/L13
- RZ/A1H
- RZ/A1L
- RZ/A2M
- RZ/T1
4. What is new in 2021-07?

<table>
<thead>
<tr>
<th>Component</th>
<th>Device</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>All</td>
<td>The Eclipse Platform has been updated to 2020-12 &amp; CDT to 10.1.0.</td>
</tr>
<tr>
<td>Coverage</td>
<td>All</td>
<td>The Eclipse platform for e2 studio has been updated to 2021-03. CDT has also been upgraded to 10.2. The main improvements for CDT relate to headless build and the Terminal window. The Coverage plugin can now show the coverage result for each function within your source files.</td>
</tr>
</tbody>
</table>
Coverage view now will support for disassembly files (with extension .asm).

You can add, delete, this kind of file in the Coverage view or observe the Coverage result of it as a .c or .cpp source file.

Quick start guide documents/videos and sample projects can be accessed directly from Welcome page of e2 studio.

By clicking "Import sample projects", an import wizard will be opened allow to search, download and import sample projects from Renesas website.

By clicking "Quick Start Guides", a new page will be opened listing useful documents/videos for each installed device family.
The FIT Configurator tool and download button has been removed from the CC-RX Project Generators.

It is recommended to use the Smart Configurator coding assistant tool for configuration of FIT drivers and middleware.
In e2 studio 2021-07, when creating new Azure RTOS project for RX, users can select sample application.

The number of sample application depends on each version of Azure RTOS software package that users downloaded and selected.

Note: If users select old version of Azure RTOS software package (for example 6.1.6_rel-rx-1.0.4) which does not support application selection, users will not see the application selection GUI when creating new project.

Code Generator components will be open for the following Smart Configurator RTOS project:

* FreeRTOS (kernel only)
* FreeRTOS (with IoT libraries)
* Azure RTOS
Renesas CC (RX/RL) project supports multiple output formats for Converter tool instead of one format as previous version.

When an existing project is upgraded the settings are modified to the new values. Returning the project to an older e2 studio version after this change means you will need to visit these options to return to the old settings.
You can generate IAR project connection files for projects with IAR toolchain.

Project connection files can be used to import an e2 studio project into the IAR Embedded Workbench tool.

If "generate project connection files" option is selected in FSP Configuration Editor preferences page, IAR project file (build.ipcf) will be generated under project directory during the project content generation stage.

The E2 emulator supports SWV for RA devices with CM33 or CM4.

SWV enables the program to output the printf data by ITM, and support to output PC sampling information from SWO pin.

This feature will require FSP 3.2.0.
e² studio now supports the generation of debug configurations for the launching of bootable application images in conjunction with a FSP-supported bootloader such as MCUboot.

These debug configurations are generated via a new Renesas FSP Boot Image launch shortcut provided on the context menu of applicable projects within the Project Explorer.

e² studio now supports the generation of bootable application images for use with an FSP-supported bootloader such as MCUboot.

These images are generated using a script provided by the bootloader component which can perform file format translation and apply security signatures as necessary.
Prior to e2 studio 2021-07 the selected property of a module was not stored which meant if the user was switching between modules in the Stacks page the Properties View was being updated but any property which was selected was being lost so the user had to search for the property on each module selection.

The selected property for each module will now be stored so that when selecting between different modules in the Stacks tab the Properties View will restore the last selected property for the selected module (if a property was selected). The selected property for each module will be stored for as long as the FSP Configuration Editor containing the modules is open.
5. Useful workarounds and information for 2021-07

Please visit the Renesas FAQ for e² studio for the latest up to date information:

Online FAQ link.

<table>
<thead>
<tr>
<th>ID</th>
<th>Component</th>
<th>Workaround or information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>When using the check for updates feature within e² studio and updating from 7.0.x to 7.1.x the initial restart after the update fails. An error message is displayed. Subsequent launches of e² studio work without issue.</td>
<td>This is caused by the update to Java.</td>
</tr>
<tr>
<td>SH support</td>
<td>The Renesas SH device family is no longer supported in e² studio.</td>
<td>If you need to use the SH device support, please use e² studio 5.4 or earlier.</td>
</tr>
<tr>
<td>Importing old projects into 6.x</td>
<td>All projects being migrated into the latest e² studio from e² studio 5.4 and earlier versions will need to be migrated to the new builder plugins. The new builder plugins have different user interface pages and different option IDs.</td>
<td>Upon opening an older workspace, the following dialog would be displayed:</td>
</tr>
</tbody>
</table>

Clicking OK will update the workspace to the newer e² studio.

Importing an existing project to the workspace or opening a workspace with old projects will automatically start the legacy project upgrade procedure.

If for some reason this process does not start it is also possible to launch the “Upgrade Legacy of e² studio Projects...” from the project context menu.
The automatic system pops up a message bubble in the bottom left of the e² studio application window.

After selecting the menu item or clicking the bubble the following dialog will be shown:

To upgrade the project, click the corresponding check box and then click Finish. Note, this will update the project to the latest build plugins and options. Before doing this, you should ensure your project is backed up as this operation is not reversible.

It is possible to upgrade multiple projects in a single operation.

For the GCC toolchains for RX, RL and GNUARM-NONE have been made to the build options which mean we cannot guarantee the same binary output after upgrade. Please consider this before upgrading.

Another consideration for migration is that debug configurations when opened in 6.0 will also need to be migrated. The following message will be displayed.
Please ensure that your projects are backed up or in revision control before migration allowing you to return to older versions if required.

**Toolchain Management**

Before e² studio 6.0 the toolchain management facility automatically upgraded or downgraded the imported project to the latest tools installed on the host machine.

This no longer happens in the latest e² studio. Instead the toolchain remains the same and user operation is the only way to change the toolchain version.

This operation is now available within the build settings on the toolchain tab. An example of CCRX is shown below:

If the particular toolchain version does not exist and build is performed, then an error message is displayed, and the build will fail.

**RZ Toolchain**

The now legacy KPIT GNU ARM-NONE toolchain is still supported within the e² studio product but now using the gnuarmeclipse plugins.

In addition RZ within e² studio now supports the GNU ARM Launchpad toolchain. Available from [https://launchpad.net/gcc-arm-embedded](https://launchpad.net/gcc-arm-embedded).

One drawback of this toolchain is that it does not have a standard library builder provided in the same manner as the legacy KPIT ARM-NONE toolchain. To use this feature for ARM Launchpad and gain access to the more efficient optlib libraries a further download is required.

This can be downloaded within the e² studio installer or directly from here: [https://gcc-renesas.com/rz/rz-download-toolchains/](https://gcc-renesas.com/rz/rz-download-toolchains/)

Once integrated it is possible to integrate the library generator from the toolchain tab of the build settings page.
See “Create Library generator” option. Once checked the library generator (libgen) is added to the available tool settings.

<table>
<thead>
<tr>
<th>QE compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>If QE for TCP/IP V1.0.0 is used, please update it to V1.0.1. Other QE series can be used with e² studio 6.0.</td>
</tr>
</tbody>
</table>

What is QE?
https://www.renesas.com/qe

Details of QE for TCP/IP
https://www.renesas.com/qe-tcip

5954 Application
- If you experience the error message “org.eclipse.swt.SWTError: No more handles” this can be caused by certain multi-monitor software and the Eclipse framework.

- If this error occurs there are 2 workarounds:
  1. Use a single monitor display.
  2. Uninstall the multiple monitor software from your graphics chipset vendor and revert to the standard Windows multi-monitor feature.

6981 RL78 Debugging
- When debugging IAR C source file with an OCD emulator (E1), the Monitor program area (0x00002-0x00003) is used.

  Therefore, this area must be excluded from usable address space. Please add ‘-HFF’ in the linker option.

  1. Open Property.
  2. Select [C/C++ build]-[Settings] at left side.
  3. Select ‘IAR RL78 Xlink linker’ at right side, add ‘-HFF’ at the textbox ‘command’.

  Not doing this will cause problems with connection and download when using interrupts.

NA Application
- If you are experiencing slow building of projects within e² studio there are some possibilities to improve.

  The system environment will attempt to find the make.exe tool via the system environment. If you ensure the directory, make resides in is at the start of the path variable it will find it more quickly. Especially important if there are network drives in the path.
In the project properties, C/C++ Build tab, behavior tab you can switch on parallel build. This will take advantage of the multi-cores on your host machine if it has them.

| NA | RZ GCC | In 3.0 the KPIT GCC RZ toolchain was supported at version 14.01. This version is no longer supported within e² studio. KPIT modified the name of their ARM toolchain to be ARM-none-eabi to follow standard ARM naming convention like other GCC toolchain vendors. The ARM-none toolchain is available at versions 14.01, 14.02 and 16.01 from the www.gcc-renesas.com website. The binaries in the 14.01 version are identical to those used in the 14.01 RZ toolchain. Once the toolchain is installed your projects will be imported and ported to ensure there is as little disruption as possible due to this change. |
| NA | KPIT GCC | The KPIT toolchains are now no longer supported by the www.kpitgnutools.com website. Support is now available from the www.gcc-renesas.com website. In addition, there are two new releases for the GNU toolchains for RX and RL78. These are now named Renesas GCC for RX and Renesas GCC for RL78. Both integrate into e² studio and can be selected from the project wizard. |

| 1922 | Application | Symptoms: Project fails to build in first instance after archive project import (not from HEW) Conditions: If an archived project is imported, it may fail to build the first time, due to a residual .d file. Workaround: Clean and Build a second time. |

| 2762 | CODAN | When using assembly code within a C source file, CODAN errors can be observed in the editor. Even though the project builds successfully, or even after rebuild index. Indexer buffer can be insufficient to process whole project. Please try giving larger values for the following configurations. Open preferences dialog through “Window”->”Preferences” menu. In “C/C++” -> “Indexer” tree, you will indexer configuration as shown below: |
Put larger values for each red-framed variables, then rebuild project or rebuild index.

2728  GDB  Step into does not always work when using the CC-RX 1.02.01 toolchain.

To ensure this behaves correctly you will need to use CC-RX 2.00.00 or greater as this issue with the debug information is corrected in this release.

NA  Eventpoints  If eventpoints do not always work just after they are set, you can use the “Apply to Target” toolbar button in the Eventpoint view to send the Eventpoints to the target manually. This will always ensure the debugger target has all the required eventpoint updates before execution starts.

5772  IAR Plugins  The IAR Plugin Manager is included in e² studio and provides support for RX, RL78, RH850 and RZ (ARM).

This tool simplifies installation and configuration of IAR toolchain plugins. You can access this through Help -> IAR Embedded Workbench plugin manager.

6184  RL78/CC-RL debugging  When the load module for RL78/G10 which created at CC-RX is debugged in E1, please specify the following option:

[Linker] -> [Device] -> "Set enable/disable on-chip debug by link option"

7217  Application  The restore default settings does not restore all the options set during project generation. Instead, it sets the defaults to the base settings for the device family in use.

7524  RZ/T1 Debugging  In a RZ/T1 RAM-based project, the "Reload" function does not work.

Reloading or re-downloading during debugging resets the device and the RAM content is erased.

To continue the debugging, disconnect and connect the debugger again.

Use spaces as tabs  Eclipse and CDT both have settings for use spaces as tabs. The option on the Editor preferences page conflicts with the CDT formatter settings.

To change the use spaces as tabs option in e² studio please use this page:
**Installer problems**

In some situations, the AVG virus checker appears to interfere with the e² studio installation process. If you experience such a problem, please temporarily disable the AVG tool and try the installation again.

**Antivirus**

In some situations, the Norton anti-virus tool can interfere with the building of Renesas Synergy projects. If possible, please disable the antivirus program when building Renesas Synergy projects on systems with Norton Antivirus installed.

**Green Hills RH850 Projects**

When debugging the RH850 object built with the Green Hills compiler in e² studio, specify the following option for the compiler option:

```
-gtws
```

The GUI setting menu is as follows.

[GHS C Compiler for V800 Standalone]-[Debugging Option]

"Generate Target-Walkable Stack" -> On

If this option is not specified, Step Over and Step Return may not work properly.

**17052 Debugging**

When debugging using a project with duplicate filenames that are in different source folders problems can be seen with breakpoint setting.

When a breakpoint is set at a source line in this file it will also stop at the same source line in the other same named file when execution passes through.

**18505 RZ debugging**

When debugging with RZ/T1 in certain situations you may experience problems stepping:

If the following conditions are met:

1. Code is located close to address 0x0
2. There is very little library code included into the project
3. There are unused functions in the program

The possibility arises that the code cannot be debugged. This due to `--gc-sections` linker option which removes the unused functions but not the related debug information.

There are several solutions to this problem:

a. disable `--gc-sections` until those functions are used
b. remove the unused functions
### RZ GCC Build
In the latest e² studio, the RZ import functionality has been improved. However, there are still possibilities of older projects causing problems when imported into e² studio.

In older versions of the RZ build plugins the FPU option was not being handled correctly. When setting the “Soft” Floating point ABI the command line was still receiving `-mfpu=vfpv3` incorrectly. This can now cause problems with older start-up code in older RZ projects.

After import if you see an error relating to this please add `-mfpu=vfpv3` to the “Other Assembler Flags” page of the Assembler tool.

In addition, when migrating some RZ/A1 projects you may experience import problems unless you build the project in 5.4 first.

### RZ DS-5 Project Import
When a DS-5 project is imported into e² studio the environment variables for Path and TCInstall are copied from the DS-5 environment.

This is not correct. The way to correct this problem is to delete both paths and replace them with correct values to your toolchain. If you are unsure how to correct this, please create a new project and copy the values from this to the converted project.

### RX & RL78 GCC Project Import
When importing a KPIT RL78/RX Library C/C++ project from e² studio 5.4 or before the build artifact settings are not correct.

The output prefix should be set to “lib” but is in fact empty.

### RZ/G debug
In the case of debugging Linux application for RZ/G, the following error messages are shown in GDB server console when pushing [Step in] button or [Step Over] button.

These messages can be ignored because the Step debugging should work properly even with these messages.

Examples of error messages:
- `PassthroughTargetCommunication::sendResponse error 42 46`
- `PassthroughTargetCommunication::sendResponse error 10 15`
- `PassthroughTargetCommunication::sendResponse error 42 46`

### 21863 RX & RL Debugging
In previous releases there were some problems with stepping in some situations when using the CCRX and CCRL toolchains.

A fix has been made to the debug object converter. To see this improvement please clean and rebuild the project. The debug information will then be updated, and the stepping will be more correct and reliable.

### Code Generator registration
When using multiple installations of e² studio on your machine you may find that subsequent installations do not work correctly with the code generator.

The effect is that the code generator cannot be created or added to projects. Existing projects can be used by the code generator views appear empty.

If this is the case, then the code generator must be manually registered. To do this execute the following tool:

```e.g.
C:\Renesas\e2_studip\eclipse\plugins\com.renesas.cg_2.11.0.v20180601-1047\CodeGenerator\Tools\register COM.bat
```
<table>
<thead>
<tr>
<th>Issue ID</th>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
</table>
| 25278    | Synergy debugging                                | When loading Symbols from multiple .elf files compiled using the IAR toolchain, the user will need to add "text" before place in FLASH_region command inside the .icf Script.  
  e.g.  
  "text":  
  place in FLASH_region { block LOCK_LOOKUP,  
  ro,  
  ro section .rodata,  
  block QSPI_NON_RETENTIVE_INIT BLOCK,  
  block RAM_INIT_CODE,  
  block USB_DEV DESC BLK }; |
| 25273    | RZ Device Migration                              | When changing the device from a RZ/A1 and attempting to swap to a RZ/T1 the device migration is not successful.  
  The source code is not migrated successfully, and the build fails.  
  This is due to the different start-up code structure between these devices.  
  In this case please create a new project and copy the required source to the newly created project. |
| 25195    | RZ/A2M Smart Configurator                        | When creating a project of RZ / A2M, the following Warning is displayed in the Problems view for the src / renesas / configuration folder.  
  "Invalid project path: Include path not found"  
  [Workaround]  
  Delete the specification of this folder with the compile option include path setting. |
| 24883    | R2/A2M                                           | RZ / A2M project generated by e² studio does not support GCC ARM 7.x or later. Please use GCC ARM 6.3. |
| 27913    | GDB server RL78                                  | When debugging with an EZ cube, real-time refresh significantly slows down debugging features and it makes e² studio look like suspended. |
| 12123    | Linker Script Editor                             | The Linker Script Editor may report errors when using some Wild Identifiers such as 1file.o and *filename.o..  
  Although these are valid file names and valid identifiers according to the Linker Script syntax, they need to be quoted when using the Linker Script Editor.  
  (e.g. "1file.o" and "filename.o"). |
| 24883    | RZ/G Linux Platform Tools                        | When using RZ/G Linux Platform Tools, gnu.io.rxtx plug-ins should be installed same as Nebula plug-ins.  
  Please follow the below steps to install gnu.io.rxtx plug-ins.  
  Start the e² studio and select [Help] -> [Install New Software] from the menu bar to open the [Install] dialog box.  
  Click on the [Add] button, enter “GNU RXTX Plugin Update Site” as a name and “http://rxtx.qbang.org/eclipse/” as a location, and click on the [OK] button. |
Select [RXTX 2.1-7r4] -> [RXTX End-User Runtime] from the list, click on the [Next] button, confirm the license, and install the plug-ins.

Due to differences in the login data between 7.8 and the 2020-04 e² studio (or later) version the FreeRTOS download feature does not work in 7.7/8 if the user has logged into MyRenesas or changed their login data details using 2020-04. If you previously used 7.7/8 prior to using 2020-04 and have not changed your login details, then both versions will work correctly.

If you need to use MyRenesas in older versions of e² studio after logging in using 2020-04 then you will need to close all e² studio instances and delete the file "%USERPROFILE%\eclipse\org.eclipse.equinox.security\secure_storage". Be aware that doing this will remove stored passwords for any Eclipse-based application.

When updating e² studio versions using an installer any installed QE tools are removed and then must be reinstalled. To preserve QE tools during an update use the "Check for Updates" function in the "Help" menu to perform an in-place online update.

When viewing flash memory in the Memory View, it can be confusing as the values for this memory type can be random for unwritten blank flash memory regions.

This can then result in many false positives for memory changes, resulting in more memory changes than expected. (red text)
To fix this the debugger supports detection and filling of blank addresses areas with a user specified hex byte value.

There is currently no user interface support for this feature. So, you need to add the following command parameters to the additional commands section of the debug configuration. The GDB command line option is: -uBlankFlaskFill=BB with the blank fill value being 0xBB. Specifying this value enables the feature, by default it is off.

37443 RA (Linux) CMSIS Pack Import feature does not work for RA on Linux

36999 RA Deleting the Debug folder from an NS project causes build failure when reference NSC guard functions.

36007 RA When debugging a secure and non-secure project - the Non-secure callable functions do not have debug information. This means you cannot set breakpoints in the secure function.

35767 RA, RZ (Linux) When importing an image using the "Image" Rendering on Linux Host the action fails. If you need to import an image on Linux please use the Raw Image memory rendering instead.

38324 RA When upgrading an e² studio 2020-04 or 2020-07 containing RA Family support to 2020-10 or later using the installer you may encounter on the features page.

To avoid this, you either need to re-select RA on the Device Family selection page or uncheck and check again "Renesas FSP Smart Configuration Core" on the Features page.

The Renesas ITRON debug views is only supported with e² studio 32bit version such as 7.8.0 currently. Enabling the Renesas ITRON debug views on e² studio 64bit version is under planning.
RA

When migrating from FSP versions before 3.0 the way pin configuration files are handled has changed. Previously the projects maintained "pincfg" files within the project directory which contained the pin data. When migrating to FSP 3.0 and the subsequently saving the migrated configuration.xml the pin data is migrated from these files to the configuration.xml file. The "pincfg" files will still appear in the pin tab until they are subsequently removed.

IDE-44277

All

In e2 studio 2021-07 the RTOS debugging integration has been switched off by default due to some debug stability problems. This feature can be unstable with some RA projects. If you wish to switch this back as it may work for you, you can do so from the debug configuration settings pages. This can be accessed via the Run->Debug Configurations menu item or via the project context menu Debug As->Debug Configurations.

IDE-43524

Symbols of inline assembler instruction could not be resolved on C/CPP standard language. They can be resolved on Renesas C/CPP Language Extend. +Renesas C/CPP Language Extends are added in Language Mappings of new project on e2studio v2021-07. +Renesas C/CPP Language Extends need to be added manually, if old project is imported to e2studio v2021-07.

IDE-43405

RA, Synergy

Microsoft have updated and improved the TraceX tool which can now be downloaded from the Microsoft Store. If you are using a new version of TraceX when configuring the tool, ensure you have checked the "Use TraceX installed from Microsoft Store" option. If you are using an older version, then uncheck this box. The configuration dialog is available in the preferences dialog. (Window->Preferences) (Renesas->TraceX category)

IDE-34814

RL, RX

The CCRX and CCRL build components now support multiple output formats for Converter tool instead of one format as previous version. If you migrate an old project to the new e2 studio and then return to the old e2 studio with the old output format. You will need to modify the settings as desired.
IDE-42025

After conversion of legacy GCC projects to LLVM the generated linker_script and start.S files should be moved to src folder. "generate" folder needs to be deleted and the path to the linker script from Settings-> Linker-> Linkerscript should be changed to "$(ProjDirPath)/src/linker_script.ld"
6. Linux version

6.1 How to install

For information on how to install the Linux product please refer to FAQ below.

- English: [https://en-support.renesas.com/knowledgeBase/19934358](https://en-support.renesas.com/knowledgeBase/19934358)
- Japanese: [https://ja-support.renesas.com/knowledgeBase/19934356](https://ja-support.renesas.com/knowledgeBase/19934356)

6.2 How to run

A. Run ‘terminal’ application of Linux.
B. Move installed directory and Run ‘e² studio’ binary file.

6.3 Register toolchain to e² studio

6.3.1 GNU ARM Embedded

Install the GNU ARM Embedded toolchain to a shared folder as follows:

```bash
sudo mkdir -p /opt
cd /opt
sudo tar jxf ~/Downloads/gcc-arm-none-eabi-7-2018-q2-update-linux.tar.bz2
```

(assuming the toolchain has been downloaded to your Downloads folder)

On first invocation you will be prompted to specify a workspace location, you will also be advised that there are no new toolchains available for integration. Open the Renesas Toolchain Management preference page using the Help → Add Renesas Toolchains menu item, then click on the Add... button and navigate to the root folder of the GNU ARM Embedded toolchain installation at /opt/gcc-arm-none-eabi-7-2018-q2-update in order to register the toolchain with e² studio:

![Renesas Toolchain Management](image.png)
6.3.2 Linaro

A. Download and extract a toolchain package file to arbitrary directory.
B. Run ‘e² studio’ and select ‘Help – Add Renesas Toolchains’
C. Select ‘Toolchain Type’ and ‘Add’ Location of toolchain.

Figure 2. Register Toolchain: Browse toolchain location

D. Click checkbox of added toolchain and restart e² studio.

Figure 3. Register Toolchain: ex) Linaro
6.4 How to build and debug RA applications Overview

6.4.1 Build

Open the New project wizard and chose an RA project.

If this is unavailable it is likely the FSP has not been installed correctly. In this case, quit e² studio, reinstall the pack(s) and restart e2 studio again.

Once the wizard completes a sample project will have been created, as well as a debug configuration for connecting the debugger.

6.4.2 Debug

Once the project has successfully built and produced a build artefact for debug, open the Debug Configurations dialog and a browse to the Renesas Hardware Debug section.

The debug configuration will match the project name – check that the settings are correct and hit Debug to connect to the device.

Checks if connection fails.

If the debug connection fails it is often for one of two reasons:

1. If using a virtual machine, make sure that the device is tied into the VM rather than the host machine.

2. If the Segger library has not installed as part of the FSP correctly open the 
"/home/user/.eclipse/com.renesas.platform_XXXXXXX/DebugComp/RA/ARM/Segger" folder and copy and paste the 'libjlinkarm.so' into the other Segger folders - e.g. 'Segger_v6.50.1'. Alternatively, take the latest file from the Segger Tools installation folder and install to the same place.
6.5 How to build and debug RZ Linux application Overview

e² studio for Linux supports building and debugging Linux applications for devices of RZ/A Group and RZ/G Group. For debugging by GDB (the GNU Project Debugger), please add Linux programs gdb-server program to Linux file system of devices and run as background process automatically. (ssh-server, tcf-agent will be needed for connection between host system and target device.) For detail about building Linux image for RZ family devices, refer to embedded Linux wiki pages (https://elinux.org) or Renesas Rulz web pages about RZ family (https://renesasrulz.com/rz). Descriptions in below is based on RZ/A1H case.

6.5.1 How to add gdb-server to RZ/A Linux root file system

A. Build root file system of RZ/A1 Linux-4.9 BSP.
   (path example: ~/rza_linux-4.9_bsp/, command example: ./build.sh buildroot)

B. Move to ‘buildroot-****’ directory in ‘output’.
   (path example: ~/rza_linux-4.9_bsp/output/buildroot-2017.02)

C. Run menuconfig (make menuconfig) and add gdb-server.
   (Select ‘Toolchain — Copy gdb server to the Target’ menu)

D. Move to ‘target’ directory in ‘output’ of ‘buildroot-****’.
   (path example: ~/rza_linux-4.9_bsp/output/buildroot-2017.02/output/target)

E. Add new file with a line as command at ‘/etc/init.d’ directory

```plaintext
File name: S51gdbserver
Command: /usr/bin/gdbserver --multi --remote-debug /dev/ttySC0
```

F. Delete or disable below contents from etc/inittab.

```plaintext
# Put a getty on the serial port
# ttySC0::respawn:/sbin/getty -L ttySC0 115200 vt100 # GENERIC_SERIAL
```

G. Move ‘Linux-4.9 BSP root’ (path example: ~/rza_linux-4.9_bsp/) and build root file system again. Download root file system at target device.
6.5.2 Linux C/C++ Project generation and build

A. Connect target device which is run as Linux, via Serial port.
B. Select ‘File – New - RZ Linux C/C++ project’ menu and make new RZ/A1H Linux C/C++ project. In phase of ‘RZ Linux connection settings’, the serial port which is used for connecting target device, will be selected automatically.

C. After editing codes, build by selecting ‘Build Project’ in right-click menu or push button.

Figure 5. New RZ Linux project & connection setting: Serial port

Figure 6. Build Project
6.5.3 GDB debug by using serial port communication

A. Terminate all processes use serial port communication such as Minicom.

B. Open ‘Configuration’ and check ‘Serial’ is selected as ‘Connection’.

C. Run debug by push button . It takes 10 or more seconds for transferring binary files to target device. Pop up message for switching to debug perspective will be shown after transferring binary files.
D. ‘Debug Perspective’ provide ways for flow controls and configurations. This public beta version e² studio for Linux doesn’t have console view for showing result of the program.
(Under development) For more detail, please see user manuals of e² studio Windows edition.

Figure 9. Debug: Control buttons, views, setting break point
7. Open Issues in 2021-07

Open issues in the e² studio 2021-07 product will be kept up to date here:

Please visit to see the latest open issue list.
8. Appendix

8.1 Website and Support

Renesas Electronics Website
http://www.renesas.com/

Inquiries
http://www.renesas.com/contact/

8.2 Web Access and Privacy Policy

Collection of User Information Applications included in this package may access the Renesas Web site. In such cases, the following information is collected and recorded to Renesas server as a log.

• Date and time of access
• Access to URLs and files
• The unique certificate number linked to your account for MyRenesas (only when you log in to MyRenesas)
• The unique identification number linked to cookies for the Web browser (for cookies, refer to the privacy policy page stated below).

Logs are managed based on our privacy policy.

Refer to our privacy policy on the following Web page.

Privacy Policy:
https://www.renesas.com/privacy.html
All trademarks and registered trademarks are the property of their respective owners.

“FreeRTOS™ is the trademark of Amazon Web Services, Inc.
AWS™, Amazon Web Services™ is the trademark of Amazon Web Services, Inc.”
GITHUB® is the trademark registered in the United States by GitHub, Inc.
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. No licenses, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.

6. The Renesas Electronics product depends on the product’s quality grade, as indicated below.
   - "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
   - "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

   Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics hardware or software products, Renesas Electronics has absolutely no liability arising out of any vulnerability or security breach, including but not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS OR ANY SYSTEMS CREATED USING RENESAS ELECTRONICS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

7. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notices, “General Notes for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to Renesas Electronics products are clarified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product category are as follows: “Standard” and “High Quality”.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notices, “General Notes for Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to Renesas Electronics products are clarified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product category are as follows: “Standard” and “High Quality”.

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including but not limited to, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. If you are the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries. (Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

Corporate Headquarters

TOYOSU FORESIA, 3-2-24 Toyosu, Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Contact information

For further information on a product, technology, the most up-to-date version of a document, or your nearest sales office, please visit:

www.renesas.com/contact

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics Corporation. All trademarks and registered trademarks are the property of their respective owners.

© 2021 Renesas Electronics Corporation. All rights reserved.